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1 Introduction 

This user manual describes how to use SmartRF® Studio 4.50. This software is 
developed by Chipcon to the courtesy of our customers. 
 
This software is made to configure the RFICs on the Evaluation Board for the 
CC400, CC900, CC1000 , CC1050,  CC1010 and CC1020. By giving out this 
software the designers of radio systems can easily evaluate the RFICs at an early 
stage in the design-process. It is further a useful tool during the generation of the 
configuration data and for finding optimised external component values.  
 
It is also a helpful tool to get to know the RFICs from Chipcon.  
 
 
 
Distribution and disclaimer: 
This software may be distributed freely under the condition that no profit is gained 
from its distribution, nor from any other program distributed in the same package. 
All files that are part of this package have to be distributed together and none of 
them may be changed in any way other than archiving or crunching. 
 
This program is distributed as freeware (and giftware). This package is provided “as 
is” without warranty of any kind. The author assumes no responsibility or liability 
whatsoever for any damage or loss of data caused by using this package. 
 
General information: 
Chipcon AS believes the furnished information is correct and accurate at the time of 
this printing. However, Chipcon AS reserves the right to make changes to this 
product without notice. Chipcon AS does not assume any responsibility for the use 
of the described product. Please refer to Chipcon’s web site for the latest update. 
 
SmartRF is a registered trademark of Chipcon AS. SmartRF is Chipcon's RF 
technology platform with RF library cells, modules and design expertise. Based on 
SmartRF Chipcon develops standard component RF-circuits as well as full custom 
ASICs based on customers' requirements. 
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2 Installation 

 

2.1 Before starting 

 
The SmartRF® Studio software runs on Win95/Win98/WinNT/Win2000 and is used 
for generating the configuration data for the CC400, CC900, CC1000, CC1050, 
CC1010 and CC1020 RFICs, connected to the evaluation board through the PC 
parallel port. 
 
The software is enclosed on a Chipcon CD-ROM. Make sure that this SmartRF® 
Studio version is the newest version available. If not, download the latest version 
from Chipcon’s website. 

2.2 System requirements 

The following table describes the system requirements for SmartRF® Studio. 
 
Category  Requirement 
Hardware IBM compatible PC, 486-based microprocessor or higher, CD-

ROM driver, parallel port. 
 
Memory  16-MB RAM minimum. 
 
Operating system Win 32 platform, i.e. Windows 95, 98, 2000 or NT. 
 

2.3 Installing the program 

 
1. Insert the Chipcon CD-ROM into your computer. 
 
2. At an MS-DOS command prompt or with Windows Explorer, copy all files to a 

destination folder on your computer 
 
The CD-ROM contains a readme.txt file and a folder named SmartRF in the 
SmartRF Studio folder. Please read the readme.txt file before starting the program. 
Files included in the software package are named SmartRF_Studio_4_50.exe, 
ccpport.dll, SmartRF_adapter.hex located in the SmartRF folder. The ccpport.dll file 
gives access to the parallel port in Windows NT and Windows 2000, and must be in 
the same directory as the SmartRF_Studio_4_50.exe file or in the windows system 
directory.  
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3 Overview of SmartRF® Studio  

 

3.1 Starting Smart RF Studio 

When starting the program a start-up splash-bitmap first appears. This gives the 
user information of the version of SmartRF® Studio. Be sure you have the latest 
version available. The splash disappears on any key stroke or after 10 seconds. 
Then a new dialog-box appears, forcing the user to select a device to work with. 
This dialog box is given below. 
 

 
 
As can be seen, the user can choose between The CC400, CC900, CC1000, 
CC1050, CC1010 and CC1020. To activate the desired RFIC, click on OK or push 
Enter, when the device is selected in the combo-box. 
 

3.2 SmartRF® Studio pull-down menus 

 
SmartRF® Studio simplifies access to its features through the use of pull-down 
menus. The SmartRF® Studio menus are shown below. 
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3.2.1 File 

 
The File menu contains items that create files and set up printing options.  
 
 

 
 
New allows you to create a new SRF-file and set default settings. 
 
Open... displays a file selection dialog box that asks you for the name of an SRF-
file and opens it. 
 
Save saves all the entered system parameters in the current SRF-file.  
 
Save As... displays a file selection dialog box that asks you for the name of an 
SRF-file in which to save the entered system parameters. 
 
Print setting to file displays a dialog box that enable you to save the entered 
system parameters together with the calculated component values in a TXT-file. 
 
Print registers to file displays a dialog box that enable you to save the register 
values to a *.txt file in Normal View and *.eep file in Register View. In Normal View 
the values will be shown in hexadecimal code for all possible modes available for 
the selected transceiver, for easy inclusion in micro-controller code. In Register 
View this selection displays a dialog box that enable you to dump the present 
register values to a file. This is useful if the register settings are different from the 
default values given in the Normal View. 
 
Load registers from file displays a dialog box that enables you to open the 
register values from a previous generated *.eep file. This option is only activate in 
Register View 
 



SmartRF® Studio User Manual 4.50 (rev. 3.5) 9

Reset settings will set the system parameters to default and update the 
configuration registers. 
 
Exit quits SmartRF® Studio. 
 
Note: When in ‘Register’ window only the Exit, Print register to file and Load 
registers from file entries will be available. 
 

3.2.2 View 

The view menu allows you to set Window options. 
 

 
 
Normal shows you the system parameter entry screen. 
 
Register shows you the configuration register screen. 
 
Toolbar displays the SmartRF® Studio toolbar when selected. 
 
Status Bar displays helpful tips at the bottom of the window when you hold the 
mouse pointer over a feature. 
 

3.2.3 Configuration 

 
The configuration menu allows you to change port address or device, and 
download the data to the device. 
 
Update Device downloads the chosen settings to the transceiver device via the 
parallel port at the back of your computer. 
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Select Port... displays a window in which you can choose between different I/O 
addresses for the parallel port (‘0x278’, ‘0x378’ or ‘0x3cb’). The default address is 
‘0x378’. A ‘Set as default’ button makes the program store the new default value. 
 
You can find the address in Windows NT by choosing ‘Windows NT Diagnostics’ 
under ‘Administrative Tools’ in the Windows ‘Start Menu’, and choose ‘Resources’ 
and ‘I/O ports’. If you have more than one parallel port, contact your local IT 
manager. 
 
Select Device displays the window that pops-up in the start of the program. Here 
you can change the device to evaluate. This selection is only active in Normal View. 

3.2.4 Tools 

 
The Tool menus have an option to select programming. This is a small program 
that let you program the CC400 and CC900 Demonstration Board. For more 
information on how this program works see chapter 6.1. 
 

3.2.5 Help 

 
The help menu provides access to useful information about the product. 
 
Help Topics brings up a message box stating where you can find further help. 
 
About SmartRF® Studio brings up a message box with the software revision and 
copyright information. 
 
Contact Chipcon brings up a message box where you can find Chipcon contact 
information and links to our web-site and mail. 

3.3 The SmartRF® Studio toolbar 

 
In addition to the pull-down menus, the toolbar provides you with simplified access 
to useful SmartRF® Studio and Windows features: 
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Icon Name  Description 

 
Reset settings:Sets the system parameters to default and updates the 
configuration registers. 
 
New: Allows you to create a new SRF-file. 
 
 
Open: Displays a file selection dialog box that asks you for the name of  

 an SRF-file and opens it. 
 
Save: Saves all the entered system parameters in the current SRF-file. 
 
Help topics: Brings up a message box stating where you can find further 

           help. 
 

3.4 The status information 

You will find status information at the bottom of the program window. This is shown 
in the figure below. 

 
The user can observe the current consumption of the transceiver in the different 
settings in the Normal View. SmartRF® Studio also monitors the lock pin of the 
transceiver.  
 
The Update device button downloads the chosen settings to the transceiver device 
via the parallel port (F5 can be used as a shortcut). 
 
The bitmap of Chipcon is a link to the Chipcon homepage. By clicking on this 
picture, your default browser goes to our website, where you can find more 
information about our RF transceivers and us. 
 
At the bottom of the window, there is a status bar, which provides hints about the 
various features in the program. 
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4 Descriptions of the different Views for CC400/CC900  

 
When CC400/CC900 is used, the program has two configuration views. The 
parameter entry screen is the default window and can be chosen by pressing F2 or 
selecting Normal from the View menu. In this window you can change the system 
parameters, get status information and component values. 
 
The other configuration window is the “register” configuration, which is selected by 
pressing F3 or selecting Register from the View menu. It gives you the possibility 
to change the bits in the configuration registers directly. This window is mainly used 
to give additional information and we dissuade you to change the bits. 
 
To send the configuration data to the transceiver chip, press F5 or select Update 
Device from the Configuration menu or press the Update device button at the 
bottom of the screen. 
 
Note: When pressing Enter the parameters will be checked and component values 
will be calculated, but the transceiver will not be programmed until Update device 
is activated. 
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4.1 The Normal configuration window for CC400/CC900 

 
When you have chosen the Normal configuration window, the SmartRF® Studio 
appears as shown in the picture below. 
 
 

 
 
 
 
You can get information about the different parameters by clicking on the info 
button to the left of the parameter. In addition to this, a tool-tip message appears 
when you move the mouse over a feature. 
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After you have changed some or all of the parameters, the external component 
values are calculated after pressing Enter or Update device. Component values 
for the Phase Lock Loop (PLL) filter and the input/output match to the antenna are 
shown to the right of the window. The values are given to you in terms of the 
standard E12-series. When you have changed the default parameter settings, use 
these values on the new external components. The component reference numbers 
refer to the application circuit shown in the datasheet. 
 
Using the specified component values for the PLL loop filter will give an optimum 
loop bandwidth for the selected system parameters. If you need a faster PLL 
settling time, i.e. a larger loop bandwidth, the data rate can be set to a higher value 
and the corresponding component values can be used.  
 
Using the specified component values for the input/output match will give an 
optimum match at the specified operating frequency. Minor tuning of the component 
values may be necessary to compensate for layout parasitics.   

4.1.1 System parameters 

 
This chapter describes the different parameters and the options you have when 
changing them. The default parameter list is given at the end of the chapter. For 
detailed information on parameter setting of CC400 and CC900 see Application 
note AN005. 

4.1.1.1 X-tal frequency 

The crystal frequency of your Development Kit evaluation board is 12.000000 MHz. 
Do not change the X-tal frequency parameter when using this module unless the 
crystal is being replaced. If you are using this program to generate configuration 
data for your special application, use a crystal frequency between 4.000 and 13.100 
MHz and replace the crystal on the printed circuit board. The crystal should be 
designed for 12pF load capacitance. The frequency value is rounded to 6 digits 
after the MHz decimal point, i.e. 12.000000 MHz. 

4.1.1.2 X-tal accuracy 

Enter the total crystal accuracy between 0 and 500 ppm, including initial tolerance, 
temperature stability, loading and ageing. If you are using a trimming capacitor to 
adjust the crystal oscillator, the initial tolerance will be zero. The crystal accuracy is 
very important for narrow-band applications (i.e. 25 kHz-channel separation). For 
applications using wider bands crystal accuracy is not that important. The crystal 
stability has an influence on the minimum possible IF filter bandwidth and the 
maximum frequency separation that can be used. For highest possible sensitivity it 
is an advantage to use a crystal with high frequency accuracy (<20 ppm). For low 
cost applications, however, this can be a trade-off. The default value is 30 ppm. 
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4.1.1.3 RF frequency 

The CC900 can operate at frequencies between 800 and 1000 MHz. The 
Development Kit evaluation board is optimised for operation in the ISM band at 
868-870 MHz. However, it is possible to use the evaluation board for frequencies 
between approximately 850 and 910 MHz restricted by the VCO tank tuning range.  
 
The CC400 can operate at frequencies between 300 and 500 MHz in 250 Hz steps. 
The Development Kit evaluation board is optimised for operation in the ISM band at 
433.920 MHz. However, it is possible to use the evaluation board for frequencies 
between approximately 400 and 460 MHz restricted by the VCO tank tuning range. 
 
Choosing  frequencies outside this range will not work for this evaluation board and 
should only be done for generation of configuration data to be used in other 
applications. 
 
Note: Depending on the crystal frequency, some RF frequencies are not allowed 
and an error message will pop up. 
 

4.1.1.4 IF stage 

For the CC900 and the CC400 there are four possible choices of IF-stage 
frequency: 60, 200, 455 kHz internal filter, or 455 kHz using an external ceramic 
filter. The default value is 200 kHz. The IF frequency is selected from a pull down 
menu. 

 
The best sensitivity is obtained using the internal 60 kHz IF-filter and offers a cost 
optimised solution. If the operating temperature range shall be large, a relative 
stable reference crystal may be required when using the 60 kHz internal IF-filter. 
Optionally the initial crystal accuracy can be tuned using a trimming capacitor.  
 
Using the 200 kHz internal IF-filter gives a very low cost solution that does not 
require a very stable crystal or a tuning capacitor. This is however obtained at the 
expense of lower sensitivity. 
 
The best selectivity is obtained with an external 455 kHz ceramic filter, but at the 
cost of lower sensitivity.  However, this can increase the cost of your system due to 
the external ceramic filter cost, and because of the narrow bandwidth of the 
external filter (typically 30 kHz) which requires a reference crystal with high 
accuracy (<±10-20 ppm). Note: When selecting the external 455 kHz filter, the user 
must ensure that the crystal accuracy together with the signal bandwidth (depend 
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on data rate and deviation) stays inside the filter bandwidth. The total occupied 
signal bandwidth can be approximated by Carson’s rule: BW = ∆f + 2 fm where fm is 
the modulation frequency. Using Manchester coding the modulation frequency (in 
kHz) will be equal to the bit rate (in kbit/s). A message-box opens when selecting 
455 external filter. This messagebox can be useful to calculate the bandwidth of the 
filter according to Carson’s rule and the crystal accuracy.  

4.1.1.5 Frequency separation 

 
The frequency separation, ∆f, is the difference between the frequency transmitted 
for a ‘0’ (f0) and a ‘1’ (f1).  That is, f0 = fC - ∆f/2 and f1 = fC + ∆f/2 where fC is the 
carrier frequency entered in the ‘RF frequency’ field.  
 
The frequency separation can be adjusted between 1 and 200 kHz in 1 kHz steps.  
The default value is 20 kHz. 
 
Depending on the chosen IF stage the recommended frequency separation is 

5 - 40 kHz for IF = 60 kHz, 
10 - 100 kHz for IF = 200 kHz. 
5 – 20 kHz for IF = 455 kHz with external filter 
 

The sensitivity depends slightly on frequency separation. 
 

4.1.1.6 Data rate 

The data rate can be set between 0.3 and 9.6 kbitps.  The default setting is 1.2 
kbitps. The data signal transmitted to the DIO pin must be Manchester encoded. 
The noise bandwidth of the receiver will be optimised to the selected data rate. 
Note that the baud rate is twice the bit rate when using Manchester coding. 
 

4.1.1.7 Power amplifier class 

You can chose between four possible choices of PA-class: ‘Class A’, ‘Class AB’, 
‘Class B’ and ‘Class C’. The default choice is ‘Class C’. The different classes are 
selected from a pull-down menu. 
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The selection of power amplifier operation class is a trade-off between output 
power, efficiency and harmonic generation. In class A or AB the amplifier is working 
more linear, and the harmonics will be low. However, the efficiency and the output 
power will also be low. For increased output power and efficiency, class B or C 
should be used, with the cost of somewhat higher harmonics. 
 

4.1.1.8 RF output power 

 
For the CC900 case, the output RF power can be set in 1 dB steps between -20 
and up to 4 dBm depending on the PA operating mode. 

Class A:  -20 to -12 dBm (not recommended due to low efficiency) 
Class AB: -15 to -5 dBm  (recommended -12 to -8 dBm) 
Class B:  -8 to 1 dBm (recommended -8 to -3 dBm) 
Class C:  -8 to 4 dBm (recommended  -8 to 4 dBm) 

 
For the CC400 case, the output RF power can be set in 1 dB steps between -5 and 
up to 14 dBm depending on the PA operating mode. 

Class A:  -5 to 0 dBm (not recommended due to low efficiency) 
Class AB: -4 to 6 dBm  (recommended -4 to 3 dBm) 
Class B:  0 to 12 dBm (recommended 3 to 12 dBm) 
Class C:  0 to 14 dBm (recommended 12 to 14 dBm) 

 
 
The default value is 0 dBm for CC900 and 10 dBm for CC400. Power in dBm is 10 
log (P) where P is in mW. 
 

4.1.1.9 Mode 

The operation mode can be selected from a pull down menu. The chip can be set in 
RX (receive), TX (transmit) or PD (power down) mode.  In PD you can select 
between complete power down (osc. off), or power down with the crystal oscillator 
running (osc. on).  
 

 
Leaving the crystal oscillator running gives a shorter turn-on time at the expense of 
higher current consumption in the power down mode. RX precharging can be used 
to reduce the demodulator turn-on time. Please refer to the data sheet for further 
information on demodulator precharging.  The default value is RX. 
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4.1.1.10 Receiver mode 

 
The receiver mode can be selected from a pull down menu. The receiver can be 
configured for optimum sensitivity (low noise figure) or optimum linearity (high input 
intercept point). When inter-modulation due to several transmitters in the same area 
is expected to be a problem, choose the optimum linearity option. Choose optimum 
sensitivity when maximum range is needed. The default value is optimum 
sensitivity. 
 

4.1.1.11 LOCK indicator 

The synthesiser PLL lock indicator can be set in one of three modes: ‘Continuous’, 
‘One-shot’ or ‘Disabled’ using the pull down window.  Choosing ‘Continuous’ the 
lock indicator will monitor the PLL lock continuously also after an initial lock has 
occurred. Choosing the ‘One-shot’ mode the lock pin will stay high after an initial 
lock has occurred, even if the PLL occasionally should fall out of lock. If ‘Disabled’ 
is selected, the lock signal will be active regardless of the PLL status. The default 
value is ‘Continuous’. 
 

 
Important: The ‘One-shot’ lock signal is used internally in the CC900 to enable the 
transmitter. If the lock signal is not active (high) the transmitter will not be enabled. 
This is done in order to avoid the transmitter to emit out-of-band signals. If 
‘Disabled’ is chosen this function is overridden and care should be taken, as the 
transmitter will transmit even when the PLL is not in lock. 

4.1.1.12 VCO current 

The VCO current can be set in 8 steps; ‘000’ being the maximum and ‘111’ being 
the minimum. The VCO current can be adjusted in order to check the gain margin 
of the VCO. Reducing the VCO current will decrease the amplitude of the VCO 
signal, and eventually the oscillator will cease to oscillate. In receive mode the LO 
leakage can be reduced by reducing the current, and hence the amplitude. 
However, the current should always be minimum two steps above where the 
oscillator stops, in order to have some start-up margin.  
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4.2 The register configuration window for CC400/CC900 

 
When you have chosen the register configuration window, the SmartRF® Studio 
will look like the picture below. 
 
 

 
 
 
In this mode you can change the 13 different bits in the 8 registers directly by 
clicking on the white squares.  These bits are used to program the transceiver chip 
on the printed circuit board (PCB) that follows Development Kit. We dissuade you 
to change the bits without contacting our company first. 
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When changing the values and pressing Enter in the Normal configuration window 
described in chapter 4.1, the frames will change automatically. At the right side of 
the window, you can see the hex codes used to configure the transceiver. Here is 
the 3 bit address added to the 13 bit data-frames, giving the hex-value of the 16-bit 
frame normally stored in an micro-controller.  



SmartRF® Studio User Manual 4.50 (rev. 3.5) 21

5 Descriptions of the different Views for CC1000 

The CC1000 has two configuration views. The parameter entry screen is the default 
window and can be chosen by pressing F2 or selecting Normal from the View 
menu. In this window you can change the system parameters, get status 
information and component values. 
 
The other configuration window is the “register” configuration, which is selected by 
pressing F3 or selecting Register from the View menu. It gives you the possibility 
to change the bits in the configuration registers directly. This window is mainly used 
to give additional information and we dissuade you to change the bits. 
 
To send the configuration data to the transceiver chip, press F5 or select Update 
Device from the Configuration menu or press the Update device button at the 
bottom of the screen. 
 
Note: When pressing Enter the parameters will be checked and component values 
will be calculated, but the transceiver will not be programmed until Update device 
is activated. 
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5.1 The Normal configuration window for CC1000 

When you have chosen the Normal configuration window, SmartRF® Studio 
appears like the picture below.   
 

 
 
You can get information about the different parameters by clicking on the info 
button to the left of the parameter.  
 
After you have changed some or all of the parameters, the external component 
values are calculated after pressing Enter or Update device. Component values 
for the input/output match to the antenna and the VCO Inductor are shown to the 
right of the window. The values are given to you in terms of the standard E12-
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series. When you have changed the default parameter settings, use these values 
for the new external components. The component reference numbers refer to the 
application circuit shown in the datasheet. 
 
Using the specified component values for the input/output match will give an 
optimum match at the specified operating frequency. Minor tuning of the component 
values may be necessary to compensate for layout parasitics.   
 

5.1.1 System parameters 

This chapter describes the different parameters and the options you have when 
changing them.  

5.1.1.1 Crystal frequency 

The crystal frequency of your Development Kit evaluation board is 14.7456 MHz. 
Do not change the X-tal frequency parameter when using this module unless the 
crystal is being replaced. If you are using this program to generate configuration 
data for your special application, use a crystal frequency between: 
   
 3 – 4 MHz 
 6 – 8 MHz 
 9 – 16 MHz 
 
Recommended frequencies are 3.6864, 7.3728, 11.0592 and 14.7456 MHz giving 
exact data rates. The recommended frequencies can be selected in the drop-down 
list. The frequency value is rounded to 6 digits after the MHz decimal point, i.e. 
11.059200 MHz.  
 

 
 
You can also choose to use an external crystal reference oscillator by selecting 
‘External’ in the radio button. 
 
The crystal frequency must be higher than 12 MHz in order to use higher data rates 
than 19.2 kbaud in SmartRF® Studio.  

5.1.1.2 Crystal accuracy 

Enter the total crystal accuracy between 0 and 500 ppm, including initial tolerance, 
temperature stability, loading and ageing. If you are using a trimming capacitor to 
adjust the crystal oscillator, the initial tolerance will be zero. The crystal stability has 
an influence on the maximum data rate and frequency separation that can be used 
to stay in the passband of the internal IF filter bandwidth. For highest possible data 
rate or separation it is an advantage to use a crystal with high frequency accuracy 
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(<20 ppm). For low cost applications, however, this can be a trade-off. The default 
value is 20 ppm. 
 

5.1.1.3 RF frequency 

CC1000 has two separate frequency settings making it possible to select between 
Frequency A and B. A radio button is used for selecting the active frequency. There 
is further a radio button on each frequency, which informs the software, whether to 
calculate RX or TX frequency.  
 

  
 
If the active frequency is different from the operation mode (see section 5.1.1.12), 
error messages will popup informing you to synchronise the active frequency with 
the operation mode.  
 
The CC1000 can operate at frequencies between 300 and 1000 MHz. The 
Development Kit evaluation board is optimised for operation in either the ISM band 
at 868-870 MHz or the ISM band at 433.050 – 434.790 MHz . However, it is 
possible to use the evaluation board for frequencies outside this ISM band with 
restriction on the VCO Inductor. Choosing frequencies outside this range will not 
work for this evaluation board and should only be done for generation of 
configuration data to be used in other applications. 
 

5.1.1.4 RX Mode 

In RX mode you can optimise the sensitivity and current consumption. 
 

 
 
The CC1000 have some RF frequencies that gives a more optimal sensitivity than 
others. By selecting the optimal frequency, SmartRF® studio will find the closest 
RX channel that gives this optimal sensitivity frequency. When optimal frequency is 
selected, SmartRF® Studio sets the selected RF frequency A to the closest optimal 
frequency, and forces frequency B to be equal to frequency A. The RF frequency B 
is disabled in optimal frequency mode. 
 
SmartRF® Studio use low side LO when mixing down to the intermediate frequency 
in RX mode. When low LO is disabled, this down converting is based on high side 
LO. The data on DIO in RX mode is inverted using high side LO. 
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In order to use CC1000 in a battery operation system, it is important to reduce the 
current consumption in RX mode. By activating the Low Current consumption, the 
current consumption in RX mode is reduced. The sensitivity will drop 1-2 dB when 
the low current mode is used. 
 
Default setting is low current and optimal frequency. 

5.1.1.5 Frequency separation 

The frequency separation, ∆f, is the difference between the frequency transmitted 
for a ‘0’ (f0) and a ‘1’ (f1).  That is, f0 = fC - ∆f/2 and f1 = fC + ∆f/2 where fC is the 
carrier frequency entered in the ‘RF frequency’ field.  
 
The frequency separation can be adjusted between 0 and 200 kHz in 1kHz steps.  
The default value is 64 kHz. A warning will pop-up if CC1000 is unable to modulate 
with the selected separation. The maximum value for the separation depends on 
the crystal frequency and RF frequency input, and will for all settings be larger than 
64 kHz.  
 

5.1.1.6 Data rate 

The data rate can be set between 0.3 and 76.8 kbaud.  The default setting is 2.4 
kbaud. If synchronous mode and recommended crystal frequencies is selected, 
SmartRF® Studio will find the closest accurate data rate. If synchronous mode is 
selected without using recommended crystal frequencies, a warning will pop-up 
informing you that the data rate will differ from the one given in the Data rate input.  
 
To get a higher data rate then 19.2 kbaud, the crystal frequency must be higher 
than 12 MHz in SmartRF® Studio. If the selected recommended frequency is 
3.6864, 7.3728 or 11.0592 MHz in synchronous mode the maximum data rate is 
forced down to 19.2 kbaud (a pop-up message will inform the user). For a 
14.745600 MHz crystal however the data rate is rounded to the closest accurate 
data rate up to 76.8 kbaud.  
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5.1.1.7 Data format 

The CC1000 can be used with NRZ (Non-Return-to-Zero) data or Manchester (bi-
phase-level) encoded data. The UART mode bypasses the on-chip synchronisation 
feature in CC1000. 
 
The fast and accurate sets the preamble time needed in RX mode, before valid 
data can be received. 
 

 
Please see data sheet of CC1000 for details. 
 
 
 

5.1.1.8 RF output power 

For the CC1000 the output RF power can be set in 1 dB steps between -20 to 10 
dBm. For frequencies higher than 500 MHz the upper limit is 5 dBm. 
 
Power in dBm is 10 log (P) where P is in mW. The default value is 0 dBm.  
 

5.1.1.9 Lock  

The synthesiser PLL lock indicator can be set in one of three modes: ‘Continuous’, 
‘One-shot’ or ‘Disabled’ using the pull down window.  Choosing ‘Continuous’ the 
lock indicator will monitor the PLL lock continuously also after an initial lock has 
occurred. Choosing the  

 
 
 
‘One-shot’ mode the CHP_OUT (lock) pin will stay high after an initial lock has 
occurred, even if the PLL occasionally should fall out of lock. If ‘Disabled’ is 
selected, the lock signal will not be sent to the CHP_OUT pin to give PLL status. 
‘External PA control’ is selected if an external Power Amplifier is needed, and 



SmartRF® Studio User Manual 4.50 (rev. 3.5) 27

‘External LNA control’ is selected if an external LNA is needed. The CHP_OUT pin 
can then control the external LNA/PA, based on the setting of the TX_PD and 
RX_PD in the MAIN register of CC1000. Please see datasheet for details. The 
default value is ‘Continuous’. 
 
Important: The ‘One-shot’ lock signal is used internally in the CC1000 to enable the 
transmitter. If the lock signal is not active (high) the transmitter will not be enabled. 
This is in order to avoid the transmitter to emit out-of-band signals. If ‘Disabled’ is 
chosen this function is overridden and care should be taken, as the transmitter will 
transmit even when the PLL is not in lock. 
 

5.1.1.10 IF/RSSI 

The IF/RSSI pin on CC1000 can be configured to give out the IF frequency  or 
RSSI. Choosing external IF, an 10.7 MHz IF signal will be available at the IF/RSSI 
pin. Using RSSI, an analogue voltage inversely proportional to the received signal 
strength is available at the pin. See datasheet for details. The default value is RSSI 
enable. 
 
 

 
 

5.1.1.11 Operation Mode 

The type of operation mode can be selected from a pull down menu. The chip can 
be set in RX (receive), TX (transmit) or PD (power down) mode.  In PD you can 
select between complete power down (osc. off), or power down with the crystal 
oscillator core, bias and/or frequency synthesiser running. Leaving the crystal 
oscillator running gives a shorter turn-on time at the expense of higher current 
consumption in the power down mode.  The default value is RX. 
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5.2 The register configuration window for CC1000 

 
 
When you have chosen the register configuration window, SmartRF® Studio will 
look like the picture below. 
 
 
 
In this mode you can change the Register values. You can enter the hex values 
directly or use the implemented control boxes for each register. These control 
boxes give detailed information on the bits to be controlled in the specified register. 
Please see the data sheet for detailed information on the register settings. When a 
hex value is written to a register and enter is pushed, the control boxes for the 
specific register will be updated and visa versa for changes made in the control 
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boxes. The bits are used to program the transceiver chip on the CC1000EB, and 
the CC1000 will be programmed with the register information when Update device 
(F5) is pushed.  We dissuade you to change the bits without first study the 
datasheet or contacting our company. 
 
When changing the values and pressing Enter in the Normal configuration window 
described in chapter  5.1, the frames will change automatically. Changing view to 
Register View the optimised register values for the Normal View is given. 
 

5.3 Evaluation Board Control 

In the CC1000 mode of SmartRF® Studio, you will find Evaluation board Control 
buttons (Calibrate, Reset and Read). The function of these buttons is given in this 
chapter.   
 
 

 
 
Calibrate activates the on-chip calibration feature of the VCO and PLL on the 
CC1000.  
 
Reset performs a hardware reset of CC1000 setting all the register to default 
values.  
 
Read starts to read back the register information on the CC1000 chip. The 
information is given in a dialog box together with the register name. This button is 
only active in register view. 
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6 Descriptions of the different Views for CC1050 

The CC1050 has two configuration views. The parameter entry screen is the default 
window and can be chosen by pressing F2 or selecting Normal from the View 
menu. In this window you can change the system parameters, get status 
information and component values. 
 
The other configuration window is the “register” configuration, which is selected by 
pressing F3 or selecting Register from the View menu. It gives you the possibility 
to change the bits in the configuration registers directly. This window is mainly used 
to give additional information and we dissuade you to change the bits. 
 
To send the configuration data to the transmitter chip, press F5 or select Update 
Device from the Configuration menu or press the Update device button at the 
bottom of the screen. 
 
Note: When pressing Enter the parameters will be checked and component values 
will be calculated, but the transmitter will not be programmed until Update device is 
activated. 
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6.1 The Normal configuration window for CC1050 

When you have chosen the Normal configuration window, SmartRF® Studio 
appears like the picture below.   
 

 
 
You can get information about the different parameters by clicking on the info 
button to the left of the parameter.  
 
After you have changed some or all of the parameters, the external component 
values are calculated after pressing Enter or Update device. Component values 
for the input/output match to the antenna and the VCO Inductor are shown to the 
right of the window. The values are given to you in terms of the standard E12-
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series. When you have changed the default parameter settings, use these values 
for the new external components. The component reference numbers refer to the 
application circuit shown in the datasheet. 
 
Using the specified component values for the output match will give an optimum 
match at the specified operating frequency. Minor tuning of the component values 
may be necessary to compensate for layout parasitics.   
 

6.1.1 System parameters 

This chapter describes the different parameters and the options you have when 
changing them.  

6.1.1.1 Crystal frequency 

The crystal frequency of your Development Kit evaluation board is 14.7456 MHz. 
Do not change the X-tal frequency parameter when using this module unless the 
crystal is being replaced. If you are using this program to generate configuration 
data for your special application, use a crystal frequency between: 
   
 3 – 4 MHz 
 6 – 8 MHz 
 9 – 16 MHz 
 
Recommended frequencies are 3.6864, 7.3728, 11.0592 and 14.7456 MHz giving 
exact data rates. The recommended frequencies can be selected in the drop-down 
list. The frequency value is rounded to 6 digits after the MHz decimal point, i.e. 
11.059200 MHz.  

 
 
You can also choose to use an external crystal reference oscillator by selecting 
‘External’ in the radio button. 
  

6.1.1.2 RF frequency 

CC1050 has two separate frequency settings making it possible to select between 
Frequency A and B. A radio button is used for selecting the active frequency.  
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The CC1050 can operate at frequencies between 300 and 1000 MHz. The 
Development Kit evaluation board is optimised for operation in either the ISM band 
at 868-870 MHz or the ISM band at 433.050 – 434.790 MHz . However, it is 
possible to use the evaluation board for frequencies outside this ISM band with 
restriction on the VCO Inductor. Choosing frequencies outside this range will not 
work for this evaluation board and should only be done for generation of 
configuration data to be used in other applications. 

6.1.1.3 Frequency separation 

The frequency separation, ∆f, is the difference between the frequency transmitted 
for a ‘0’ (f0) and a ‘1’ (f1).  That is, f0 = fC - ∆f/2 and f1 = fC + ∆f/2 where fC is the 
carrier frequency entered in the ‘RF frequency’ field.  
 
The frequency separation can be adjusted between 0 and 200 kHz in 1 kHz steps.  
The default value is 64 kHz. A warning will pop-up if CC1050 are unable to 
modulate with the selected separation. The maximum value for the separation 
depends on the crystal frequency and RF frequency input, and will for all settings 
be larger than 64 kHz.  
 

6.1.1.4 Data rate 

The data rate can be set between 0.6 and 76.8 kbaud.  The default setting is 2.4 
kbaud. If synchronous mode and recommended crystal frequencies is selected, 
SmartRF® Studio will find the closest accurate data rate. If synchronous mode is 
selected without using recommended crystal frequencies, a warning will pop-up 
informing you that the data rate will differ from the one given in the Data rate input.  
 

6.1.1.5 Data format 

The CC1050 can be used with NRZ (Non-Return-to-Zero) data or Manchester (bi-
phase-level) encoded data. The UART mode bypasses the on-chip synchronisation 
feature in CC1050. 

 
 
Please see data sheet of CC1050 for details. 
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6.1.1.6 RF output power 

For the CC1050 the output RF power can be set in 1 dB steps between -20 to 12 
dBm. For frequencies higher than 500 MHz the upper limit is 8 dBm. 
 
Power in dBm is 10 log (P) where P is in mW. The default value is 0dBm.  

6.1.1.7 Lock  

The synthesiser PLL lock indicator can be set in one of three modes: ‘Continuous’, 
‘One-shot’ or ‘Disabled’ using the pull down window.  Choosing ‘Continuous’ the 
lock indicator will monitor the PLL lock continuously also after an initial lock has 
occurred. Choosing the  
 

 
‘One-shot’ mode the CHP_OUT (lock) pin will stay high after an initial lock has 
occurred, even if the PLL occasionally should fall out of lock. If ‘Disabled’ is 
selected, the lock signal will not be sent to the CHP_OUT pin to give PLL status. 
‘External PA control’ is selected if an external Power Amplifier is needed. The 
CHP_OUT pin can then control the external PA, based on the setting of the TX_PD 
in the MAIN register of CC1050. Please see datasheet for details. The default value 
is ‘Continuous’. 
 
Important: The ‘One-shot’ lock signal is used internally in the CC1050 to enable the 
transmitter. If the lock signal is not active (high) the transmitter will not be enabled. 
This is in order to avoid the transmitter to emit out-of-band signals. If ‘Disabled’ is 
chosen this function is overridden and care should be taken, as the transmitter will 
transmit even when the PLL is not in lock. 
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6.1.1.8 Mode 

The type of operation mode can be selected from a pull down menu. The chip can 
be set in TX (transmit) or PD (power down) mode.  In PD you can select between 
complete power down (osc. off), or power down with the crystal oscillator core, bias 
and/or frequency synthesiser running. Leaving the crystal oscillator running gives a 
shorter turn-on time at the expense of higher current consumption in the power 
down mode.  The default value is TX. 
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6.2 The register configuration window for CC1050 

When you have chosen the register configuration window, SmartRF® Studio will 
look like the picture below. 
 

 
 
In this mode you can change the Register values. You can enter the hex values 
directly or use the implemented control boxes for each register. These control 
boxes give detailed information on the bits to be controlled in the specified register. 
Please see the data sheet for detailed information on the register settings. When a 
hex value is written to a register and enter is pushed, the control boxes for the 
specific register will be updated and visa versa for changes made in the control 
boxes. The bits are used to program the transmitter chip on the CC1050EB, and 
the CC1050 will be programmed with the register information when Update device 
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(F5) is pushed.  We dissuade you to change the bits without first study the 
datasheet or contacting our company. 
 
When changing the values and pressing Enter in the Normal configuration window 
described in chapter  6.1, the frames will change automatically. Changing view to 
Register View the optimised register values for the Normal View is given. 
 

6.3 Evaluation Board Control 

In the CC1050 mode of SmartRF® Studio, you will find Evaluation board Control 
buttons (Calibrate, Reset and Read). The function of these buttons is given in this 
chapter.   
 
 

 
 
Calibrate activates the on-chip calibration feature of the VCO and PLL on the 
CC1050.  
 
Reset performs a hardware reset of CC1050 setting all the register to default 
values.  
 
Read starts to read back the register information on the CC1050 chip. The 
information is given in a dialog box together with the register name. This button is 
only active in register view. 
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7 Descriptions of the different Views for CC1010 

The CC1010 has two configuration views. The parameter entry screen is the default 
window and can be chosen by pressing F2 or selecting Normal from the View 
menu. In this window you can change the system parameters, get status 
information and component values. 
 
The other configuration window is the “register” configuration, which is selected by 
pressing F3 or selecting Register from the View menu. It gives you the possibility 
to change the bits in the configuration registers directly. This window is mainly used 
to give additional information and we dissuade you to change the bits. 
 
To send the configuration data to the transceiver chip, press F5 or select Update 
Device from the Configuration menu or press the Update device button at the 
bottom of the screen. In order to configure the CC1010EB, you first need an 
embedded software (SmartRF®_adapter.hex) inside CC1010 that communicate 
with the SmartRF® Studio. SmartRF® Studio will check the embedded software the 
first time Update device is activated. If the CC1010 embedded software differs 
from the required software (SmartRF_adapter.hex), a programming application 
(ccprog.exe) will be activated, allowing the user to configure CC1010 with the 
software SmartRF®_adapter.hex. The user only need to click on the Do it button in 
order to update the CC1010 core with the required embedded software. After 
verifying the programming the user can exit this programming window and work 
with the SmartRF® Studio window. For additional information regarding the 
programming application (ccprog.exe), please study the IDE User Manual. 
 
Note: When pressing Enter the parameters will be checked and component values 
will be calculated, but the transceiver will not be programmed until Update device 
is activated.  
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7.1 The Normal configuration window for CC1010 

When you have chosen the Normal configuration window, SmartRF® Studio 
appears like the picture below.   
 

 
 
You can get information about the different parameters by clicking on the info 
button to the left of the parameter.  
 
After you have changed some or all of the parameters, the external component 
values are calculated after pressing Enter or Update device. Component values 
for the input/output match to the antenna and the VCO Inductor are shown to the 
right of the window. The values are given to you in terms of the standard E12-
series. When you have changed the default parameter settings, use these values 
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for the new external components. The component reference numbers refer to the 
application circuit shown in the datasheet. 
 
Using the specified component values for the input/output match will give an 
optimum match at the specified operating frequency. Minor tuning of the component 
values may be necessary to compensate for layout parasitics.   
 

7.1.1 System parameters 

This chapter describes the different parameters and the options you have when 
changing them.  

7.1.1.1 Crystal frequency 

The crystal frequency of your Development Kit evaluation board is 14.7456 MHz. 
Do not change the X-tal frequency parameter when using this module unless the 
crystal is being replaced. If you are using this program to generate configuration 
data for your special application, use a crystal frequency between: 
   
 3 – 4 MHz 
 6 – 8 MHz 
 9 – 24 MHz 
 
Recommended frequencies are 3.6864, 7.3728, 11.0592, 14.7456, 18.4320 and 
22.1184 MHz giving exact data rates. The recommended frequencies can be 
selected in the drop-down list. The frequency value is rounded to 6 digits after the 
MHz decimal point, i.e. 11.059200 MHz.  
 

 
 
You can also choose to use an external crystal reference oscillator by selecting 
‘External’ in the radio button. 
 
The crystal frequency must be 14.7456 MHz in order to use the maximum data rate 
of 76.8 kbaud in SmartRF® Studio. For 22.1184 and 7.3728 MHz the maximum 
data rate is 38.4 kbaud. The other recommended crystal frequencies will give a 
maximum data rate of 19.2 kbaud. 

7.1.1.2 Crystal accuracy 

Enter the total crystal accuracy between 0 and 500 ppm, including initial tolerance, 
temperature stability, loading and ageing. If you are using a trimming capacitor to 
adjust the crystal oscillator, the initial tolerance will be zero. The crystal stability has 
an influence on the maximum data rate and frequency separation that can be used 
to stay in the passband of the internal IF filter bandwidth. For highest possible data 
rate or separation it is an advantage to use a crystal with high frequency accuracy 
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(<20 ppm). For low cost applications, however, this can be a trade-off. The default 
value is 20 ppm. 
 

7.1.1.3 RF frequency 

CC1010 has two separate frequency settings making it possible to select between 
Frequency A and B. A radio button is used for selecting the active frequency. There 
is further a radio button on each frequency, which informs the software, whether to 
calculate RX or TX frequency.  
 

  
 
If the active frequency is different from the operation mode (see section 5.1.1.12), 
error messages will popup informing you to synchronise the active frequency with 
the operation mode. This check is performed on Update device. 
 
The CC1010 can operate at frequencies between 300 and 1000 MHz. The 
Development Kit evaluation board is optimised for operation in either the ISM band 
at 868-870 MHz or the ISM band at 433.050 – 434.790 MHz . However, it is 
possible to use the evaluation board for frequencies outside this ISM band with 
restriction on the VCO Inductor. Choosing frequencies outside this range will not 
work for this evaluation board and should only be done for generation of 
configuration data to be used in other applications. 
 

7.1.1.4 RX Mode 

In RX mode you can optimise the sensitivity. 
 

 
 
The CC1010 have some RF frequencies that gives a more optimal sensitivity than 
others. By selecting the optimal frequency, SmartRF® studio will find the closest 
RX channel that gives this optimal sensitivity frequency. When optimal frequency is 
selected, SmartRF® Studio sets the selected RF frequency A to the closest optimal 
frequency, and forces frequency B to be equal to frequency A. The RF frequency B 
is disabled in optimal frequency mode. 
 
SmartRF® Studio use low side LO when mixing down to the intermediate frequency 
in RX mode. When low LO is disabled, this down converting is based on high side 
LO. The data on DIO in RX mode is inverted using high side LO. 
 
Default setting is optimal frequency and low LO. 
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7.1.1.5 Frequency separation 

The frequency separation, ∆f, is the difference between the frequency transmitted 
for a ‘0’ (f0) and a ‘1’ (f1).  That is, f0 = fC - ∆f/2 and f1 = fC + ∆f/2 where fC is the 
carrier frequency entered in the ‘RF frequency’ field.  
 
The frequency separation can be adjusted between 0 and 200 kHz in 1kHz steps.  
The default value is 64 kHz. A warning will pop-up if CC1010 is unable to modulate 
with the selected separation. The maximum value for the separation depends on 
the crystal frequency and RF frequency input, and will for all settings be larger than 
64 kHz.  
 

7.1.1.6 Data rate 

The data rate can be set between 0.3 and 76.8 kbaud.  The default setting is 2.4 
kbaud. If synchronous mode and recommended crystal frequencies is selected, 
SmartRF® Studio will find the closest accurate data rate. If synchronous mode is 
selected without using recommended crystal frequencies, a warning will pop-up 
informing you that the data rate will differ from the one given in the Data rate input.  
 
To get a higher data rate then 19.2 kbaud, the crystal frequency must be higher 
than 12 MHz in SmartRF® Studio. If the selected recommended frequency is 
3.6864, 11.0592, 18.4320 MHz in synchronous mode the maximum data rate is 
forced down to 19.2 kbaud (a pop-up message will inform the user). For a 
14.745600 MHz crystal however the data rate is rounded to the closest accurate 
data rate up to 76.8 kbaud and for 7.3728 and 22.1184 MHz the maximum data 
rate is 38.4 kbaud.  

7.1.1.7 Data format 

The CC1010 can be used with NRZ (Non-Return-to-Zero) data or Manchester (bi-
phase-level) encoded data. The UART mode bypasses the on-chip synchronisation 
feature and the Transparent mode bypass both the synchronisation and 
oversampling algorithm in CC1010. 
 
The fast and accurate sets the preamble time needed in RX mode, before valid 
data can be received. 
 

 
 
Please see data sheet of CC1010 for details. 
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7.1.1.8 RF output power 

For the CC1010 the output RF power can be set in 1 dB steps between -20 to 10 
dBm. For frequencies higher than 500 MHz the upper limit is 4 dBm. 
 
Power in dBm is 10 log (P) where P is in mW. The default value is 0 dBm.  
 

7.1.1.9 Lock  

The synthesiser PLL lock indicator can be read from an internal register. This read 
operation is done each second and can be disabled if the constantly reading of the 
register influences testing parameters.  
 
 

 
 
 

7.1.1.10 IF/RSSI 

The AD2 pin on CC1010 can be configured to give out the IF frequency or RSSI. 
Choosing external IF, a 10.7 MHz IF signal will be available on the AD2 pin. Using 
RSSI, an analogue voltage inversely proportional to the received signal will then be 
available on this pin. See datasheet for details. The default value is RSSI enable. 
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7.1.1.11 Operation Mode 

The type of operation mode can be selected from a pull down menu. The chip can 
be set in RX (receive), TX (transmit) or PD (power down) mode.  In PD you can 
select between complete power down (osc. off), or power down with the crystal 
oscillator core, bias and/or frequency synthesiser running. Leaving the crystal 
oscillator running gives a shorter turn-on time at the expense of higher current 
consumption in the power down mode.   
 

 
 
The default value is RX. 
 

7.1.1.12 Built in test 

A built-in BER-estimator and signal generator is implemented in the SmartRF® 
Studio adapter program.  
 

 
 
In RX mode the BER-estimator can be used in conjunction with an RF signal 
generator connected to the DIO connector. The selected signal type (SIGTYPE) is 
then provided on the DIO pin and is used as a reference sequence. The BER-
estimator locks onto the received signal and then compares it to the signal 
transmitted on DIO, measuring the BER over a configurable number of transmitted 
bits given by BER window (BERWIN). When this measurement window is 
complete, the numbers of bits in error are transferred to SmartRF®  Studio together 
with the estimated BER. The maximum data rate for the BER estimator is 4.8 
kbaud. In TX mode the selected signal type is transmitted over the RF link. 
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7.2 The register configuration window for CC1010 
 
 
When you have chosen the register configuration window, SmartRF® Studio will 
look like the picture below. 
 

 
 
In this mode you can change the Register values. You can enter the hex values 
directly or use the implemented control boxes for each register. These control 
boxes give detailed information on the bits to be controlled in the specified register. 
Please see the data sheet for detailed information on the register settings. When a 
hex value is written to a register and enter is pushed, the control boxes for the 
specific register will be updated and vice versa for changes made in the control 
boxes. The bits are used to program the transceiver chip on the CC1010EB, and 
the CC1010 will be programmed with the register information when Update device 
(F5) is pushed.  We dissuade you to change the bits without first study the 
datasheet or contacting our company. 
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When changing the values and pressing Enter in the Normal configuration window 
described in chapter 7.1, the frames will change automatically. Changing view to 
Register View the optimised register values for the Normal View is given. 
 

7.3 Evaluation Board Control 

In the CC1010 mode of SmartRF® Studio, you will find Evaluation board Control 
buttons (Calibrate, Reset and Read). The function of these buttons is given in this 
chapter.   
 
 

 
 
Calibrate activates the on-chip calibration feature of the VCO and PLL on the 
CC1010.  
 
HW Reset performs a hardware reset of CC1010 setting all the register to default 
values.  
 
Read starts to read back the register information on the CC1010 chip. The 
information is given in a dialog box together with the register name. This button is 
only active in register view. 
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8 Descriptions of the different Views for CC1020 

The CC1020 has two configuration views. The parameter entry screen is the default 
window and can be chosen by pressing F2 or selecting Normal from the View 
menu. In this window you can change the system parameters, get status 
information and component values. 
 
The other configuration window is the “register” configuration, which is selected by 
pressing F3 or selecting Register from the View menu. It gives you the possibility 
to change the bits in the configuration registers directly. This window is mainly used 
to give additional information and we dissuade you to change the bits. 
 
To send the configuration data to the transceiver chip, press F5 or select Update 
Device from the Configuration menu or press the Update device button at the 
bottom of the screen. 
 
Note: When pressing Enter the parameters will be checked and component values 
will be calculated, but the transceiver will not be programmed until Update device 
is activated. 
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8.1 The Normal configuration window for CC1020 

When you have chosen the Normal configuration window, SmartRF® Studio 
appears like the picture below.   
 

 
 
You can get information about the different parameters by clicking on the info 
button to the left of the parameter.  
 
After you have changed some or all of the parameters, the external component 
values are calculated after pressing Enter or Update device. The values are given 
in terms of the standard E12-series. When you have changed the default parameter 
settings, use these values for the new external components. The component 
reference numbers refer to the application circuit shown in the datasheet and the 
CC1020DK User Manuals. 



SmartRF® Studio User Manual 4.50 (rev. 3.5) 49

 
Using the specified component values for the input/output match will give an 
optimum match at the specified operating frequency. Minor tuning of the component 
values may be necessary to compensate for layout parasitics.   
 

8.1.1 System parameters 

This chapter describes the different parameters and the options you have when 
changing them.  

8.1.1.1 Crystal frequency 

The crystal frequency of your Development Kit evaluation module is 14.7456 MHz. 
Do not change the X-tal frequency parameter when using this module unless the 
crystal is being replaced. If you are using this program to generate configuration 
data for your special application, use a crystal frequency between: 
   
 4 - 20 MHz 
 
Recommended frequencies are 4.9152, 7.3728, 9.8304, 12.288, 14.7456, 17.2032 
and 19.6608 MHz giving exact data rates. The recommended frequencies can be 
selected in the drop-down list. The frequency value is rounded to 6 digits after the 
MHz decimal point, i.e. 14.745600 MHz.  
 

 
 
You can also choose to use an external crystal reference oscillator by selecting 
‘External’ in the radio button. 
 

8.1.1.2 Crystal accuracy 

Enter the total crystal accuracy between 0 and 100 ppm, including initial tolerance, 
temperature stability, loading and ageing. If you are using a trimming capacitor to 
adjust the crystal oscillator, the initial tolerance will be zero. The crystal stability has 
an influence on the maximum data rate and frequency separation that can be used 
to stay in the passband of the internal programmable IF filter bandwidth. The 
default value is 5 ppm. 
 

8.1.1.3 RF frequency 

CC1020 has two separate frequency settings making it possible to select between 
Frequency A and B. A radio button is used for selecting the active frequency. There 
is further a radio button for each frequency, which informs the software, whether to 
calculate RX or TX frequency.  
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If the active frequency is different from the operation mode (see section 8.1.1.12), 
error messages will popup informing you to synchronise the active frequency with 
the operation mode.  
 
CC1020 can operate at frequencies between 424 – 470 MHz and 848 - 940 MHz. 
Your Development Kit test module is optimised for operation in the ISM band at 868 
or 433 MHz. However, it is possible to use the test module for frequencies outside 
this ISM band with the restriction of the external components. 
 
  

8.1.1.4 Frequency separation 

The frequency separation dF can be between 0 and 108 kHz at 424 – 470 MHz, 
and between 0 and 216 kHz at 848 – 940 MHz.. This is the difference between the 
frequency transmitted for a ‘0’ (F0) and a ‘1’ (F1). That is, F0 = Fc- dF/2 and F1= 
Fc+ dF/2, where Fc is the carrier frequency entered in the ‘RF frequency’ field. The 
total occupied signal bandwidth can be approximated by Carson’s rule: BW =  dF + 
2 Fm, where Fm is the modulation frequency. Using NRZ coding the baud rate is 
equal to the bit rate. Using Manchester coding the modulation frequency (in kHz) 
will be equal to the bit rate (in kbit/s) and the baud rate is twice the bit rate. 

8.1.1.5 Data rate 

The data rate can be set between 0.45 and 153.6 bBaud. Using NRZ mode, the 
data rate in kbits/s is equal to the Baud rate. Using Manchester code, the Baud rate 
is twice the bit rate. The demodulator, data slicer and bit synchroniser is optimised 
according to the selected data rate. 
 
In synchronous mode using recommended crystal frequencies, the data rate will be 
rounded to the closest accurate data rate given in the data sheet.  

8.1.1.6 Data format 

CC1020 can be configured for three different data formats: Synchronous ‘NRZ’, 
Synchronous ‘Manchester’ or ‘Asynchronous UART’.  The data formats refer to the 
encoding used when modulating the signal, either NRZ (Non-Return-to-Zero) data 
or Manchester encoded data (also known as bi-phase-level) can be used. In the 
synchronous modes CC1020 provide the data clock at DCLK.  
 
When Manchester mode is selected, the output signal will be modulated even if no 
signal is connected to the DIO line. This is because the Manchester coding of the 
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data is done by the CC1020. Therefore the DIO signal should be NRZ coded even 
when Manchester mode is selected. 
 

 
 
The selection between Fast and Accurate controls the settling time of the averaging 
filter in the demodulator. Please see the data sheet for details. 

8.1.1.7 RF output power 

For the CC1020 the output RF power can be set in 1 dB steps between -20 to 2 
dBm. For frequencies lower than 500 MHz the upper limit is TBD dBm. 
 
Power in dBm is 10 log (P) where P is in mW. The default value is 0 dBm.  

8.1.1.8 Channel spacing 

The 6 dB IF bandwidth is programmable according to the channel spacing needed. 
In narrow band operation the IF bandwidth is critical in order to get good adjacent 
channel rejection. Further the AGC in CC1020 will be optimised based on the 
channel spacing selection. 
 

 

8.1.1.9 Modulation 

CC1020 can modulate FSK, GFSK or OOK/ASK. Using GFSK the data is shaped, 
using a Gaussian filter before FSK modulation, in order to improve the occupied 
bandwidth.  OOK is a type of amplitude modulation used in digital systems where 
the RF carrier is turned on and off in order to modulate the data.  
 

 
In a fractional-N synthesizer, spurious signals can occur at certain frequencies 
depending on the division ratios in the PLL. To reduce the strength of these spurs 
the Dithering can be enabled. 
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8.1.1.10 Lock  

The synthesiser PLL lock indicator can be set in one of three modes: ‘Continuous’, 
‘One-shot’ or ‘Disabled’.  Choosing ‘Continuous’ the lock indicator will monitor the 
PLL lock continuously also after an initial lock have occurred. Choosing the ‘Instant’ 
mode the LOCK pin will stay high after an initial lock has occurred, even if the PLL 
occasionally should fall out of lock. If ‘Disabled’ is selected, the lock signal will be 
fixed to high or low regardless of the PLL status. The LOCK pin can also be used 
as a Carrier Sense indicator or be set to a fixed level. In synchronous mode the 
data in RX mode can be given on the LOCK pin when Data output is selected. In 
asynchronous mode the data output is always provided on DCLK. 
 

 
 
Note that the Lock indicator pin on CC1020 is active low. 

8.1.1.11 Carrier sense 

The carrier sense signal is based on the RSSI value and the programmable carrier 
sense level. The Carrier sense signal is high as long as the RSSI is stronger than 
the given threshold. The threshold is given by the sensitivity in RX mode and 
adding the carrier sense offset.  
 

 
 
The DCLK pin on CC1020 can be used to give an interrupt signal to the MCU when 
the RSSI level exceeds the given threshold level. This function can be used to 
wake or interrupt the MCU when a strong signal is received. The DCLK Squelch 
enables this feature. 
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8.1.1.12 Operation Mode 

The chip can be set in RX (receive), TX (transmit) or PD (power down) mode.  You 
can also power up selected parts of the chip; the crystal oscillator core, the bias 
module and the synthesiser. These modes can be used to evaluate performance 
during a power up sequence.  
 
The disabled ‘Start mode’ button will be activated in ‘TX Pseudo Random’ and 
‘Automatic power up sequence’ selection and the caption will change to 
respectively ‘Start PN9’ and ‘wake-up’. 
 

 
 
When Automatic power up sequence is selected, the CC1020 wakes up in RX 
mode and check the carrier sense signal.  The power up sequencing is initiated by 
a negative transition on PSEL. Pushing the ‘wake up’ button does this.  Please refer 
to the data sheet for further information on power-on sequencing.  
 
If pseudo random sequence is selected, the DIO is XOR’ed with this predefined 
sequence both in TX and RX. BER can easily be found by having DIO low in TX 
and count the number of ‘1’ received on the DIO in RX and devide by 3. The 
pseudo random sequence in TX mode is initiated by a negative transition on PSEL. 
Pushing the ‘Start PN9’ button does this. 
 
 
 

8.1.1.13 Diagnose 

By enabling the diagnose feature, the averaging value of the RSSI, AFC and IF 
offset is calculated and updated each second. The RSSI signal is given in dBm and 
the AFC and IF Offset is given in kHz. For optimum sensitivity the crystal loading, or 
the RX frequency should be tuned until AFC indicates 0 kHz. 
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8.2 The register configuration window for CC1020 

When you have chosen the register configuration window, SmartRF® Studio will 
look like the picture below. 
 

 
 
In this mode you can change the Register values by enter the hex values. Please 
see the data sheet for detailed information on the register settings. The registers 
are used to program the transceiver chip on the CC1020EM, and the CC1020 will 
be programmed with the register information when Update device (F5) is pushed. 
You can also configure each register by pushing the update button for the 
respective register entry.  We dissuade you to change the bits without first study the 
datasheet or contacting our company. 
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When changing the values and pressing Enter in the Normal configuration window 
described in chapter  5.1, the frames will change automatically. Changing view to 
Register View the optimised register values for the Normal View is given. 
 

8.3 Evaluation Board Control 

In the CC1020 mode of SmartRF® Studio, you will find Evaluation board Control 
buttons (Calibrate, Reset and Read). The function of these buttons is given in this 
chapter.   
 

 
 
Calibrate activates the on-chip calibration feature of the VCO and PLL on the 
CC1020.  
 
Reset performs a hardware reset of CC1020 setting all the register to default 
values.  
 
Read starts to read back the register information on the CC1020 chip. The 
information is given in a dialog box together with the register name. This button is 
only active in register view. 
 
Diagnose performs a read-back of the status registers. In normal view the read-
back values are provided in signed format (when needed) and the value of each bit 
in the STATUS register is listed up. Further the CC1020 version is given in this 
window. In register view the read back value of the status register is provided as 
register value in hex format. 
 
 
Calibrate IR is only active in Register view, and performs a calibration algorithm 
that improves the image rejection feature on CC1020. In order to use this feature 
you need to connect a signal generator operation on the image frequency. Please 
see data sheet for details. 
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9 Description of the Tools in SmartRF® Studio 

Tools in the SmartRF® Studio are small independent software programs that are 
accessible from the Tools menu.     
 

9.1 Programming 

It is possible to program the microcontroller on the Demonstration Board for the 
CC400 and the CC900 from SmartRF® Studio. Selecting Programming in the 
Tools menu (Alt+T+P) open a new window tool for this demonstration board 
programming. This window is as shown below. 
 

 
The interface communicates with the Evaluation Board. Before programming can 
start, you must plug the Demonstration Board into the edge connector on the 
CC400/900 Evaluation Board. The software will inform you if you have not installed 
the Demonstration Board correctly on the demonstrator before programming. 
Please see the User Manuals for the Development Kit for details regarding the 
Evaluation Board and Demonstration Board.  
 
Before programming the demonstration board the battery should be removed, 
because the Evaluation board gives power to the MCU during programming. 

9.1.1 EEPROM-programming 

The register setting for the transceivers is stored in the EEPROM of the 
microcontroller.  The idea is that the user can change the settings of the 
transceivers on the demonstrator by changing the data in the EEPROM.  
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Before you can program the EEPROM, you must load valid data into the EEPROM-
buffer. This can be done by either using the default setting, load from file or read 
from board.  
 
If default setting is selected, then the EEPROM-buffer is filled with default values 
that correspond to the data in the demonstration board when you got it. This is a 
proper selection when you want to go back to the recommended settings after 
testing the demonstrator using other settings. To use the correct default setting for 
the demonstrator board, the user must ensure that the selected device in 
SmartRF® Studio is the same as the transceiver on the demonstration board. If 
CC400 is selected the default setting is according to the EEPROM setting given in 
CC400DBK User Manual, and if CC900 is selected the default setting is according 
to the EEPROM setting given in CC900DBK User Manual. If CC1000 is selected 
before the programming tool is opened, the default setting radio button will not give 
a default setting, because we have for the moment not implemented a 
demonstrator for CC1000. 
 
If from file is selected, then the load and the save buttons are enabled. Here you 
can either load data from a file to the EEPROM-buffer, or save the EEPROM-buffer 
to a file. There are two types of files that are allowed to load. That is the *.eep and 
*.txt. The eep-format is the normal file type for the EEPROM data. The txt-file is the 
text-file that is generated under SmartRF® Studio when print register to file is 
selected in Normal View. If another text-file is loaded an error message will open. 
When saving the buffer to a file, the format will be of  *.eep.  
 
If from board is selected, then the read and save buttons are enabled. By clicking 
on this button, the software starts to read the EEPROM of the connected 
demonstration board, into the EEPROM-buffer. The Progress bar at the bottom of 
the EEPROM-programming frame starts to go, and indicate the progress of the 
reading. An error message will open if no demonstrator is connected to the 
evaluation board. The buffer data can now be used to either program to another 
board or store to a *.eep file. 
 
When the EEPROM-buffer contains useful data, the program EEPROM button is 
enabled. This button writes the data from the EEPROM-buffer to the EEPROM of 
the microcontroller. The Progress bar at the bottom of the EEPROM-programming 
frame indicates the progress of the programming. An error message will be shown 
if no demonstrator is connected to the evaluation board. 
 

9.1.2 FLASH-programming 

The main program of the microcontroller is stored in the FLASH memory. This 
program can be loaded into the FLASH-buffer. The file-format is generic Hex 
Format (ASCII-file). Please have in mind that not all types of hex format can be 
used in SmartRF® Studio. The format SmartRF® Studio can handle is given below:  
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000000:c005 
000001:c115 
000002:c125 
000003:c0a9 
000004:c001 
000005:c000 
…… 
 
the generic hex format is of the type: 
 
AAAAAA:DDDD 
 
Where: 
 
A = Address 
D = Data 
 
When the FLASH-buffer contains useful data,  the program FLASH button is 
enabled. This button writes the data from the FLASH-buffer to the FLASH memory 
of the microcontroller. The Progress bar at the bottom of the FLASH-programming 
frame indicates the progress of the programming. An error message will be shown 
if no demonstrator is connected to the evaluation board. 
 
Please have in mind that the EEPROM is erased during the FLASH-programming, 
and must manually be updated by the user with the program EEPROM button (see 
8.1.1).  
 
Please also have in mind that the FLASH programmer in SmartRF® Studio can 
only be used on a CC400/CC900DB v.2.00 or newer, due to the new Atmel MCU 
(tiny12) on this board. 
 
 
Note: To generate a generic hex file in AVR Studio (use version 3.5 or newer), click on 'Project 
Settings' in the 'Project' menu, and select 'Generic' in the 'Output File Format' combo box. For 
further information, see Atmel's documentation. 
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